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PART I Introduction  

1.1 WELCOME 

Thank you for your product purchase!  With Cleanscape Fortran-lint (Flint), you 
have the most powerful static source (lint) analysis available for Fortran 77/90/95 
code.  Flint in its command-line form has been assisting Fortran programmers for a 
quarter century; the GUI is an ease-of-use enhancement to the venerable Flint 
product for a new generation programmers – and anyone tired of command prompts 
or desiring the productivity gains from using a GUI.  

1.2 DOCUMENTATION  

This is the “quick start” guide for the Flint static analyzer.  There are three modes 
of Flint operation on Unix/Linux, and two on Windows: 

A. Cleanscape GUI 

B. Command line 

C. Xlint graphical browser (Unix/Linux only).  This product remains under 
support, but the Flint GUI effectively supersedes its functionality. 

This document’s sole purpose is to describe the ease-of-use enhancements provided 
by Cleanscape GUI over the Flint command-line product.  Flint is very rich in 
analysis controls and reporting; to gain maximum benefit from your product 
purchase, we urge you to read and keep handy the companion document, Flint 
Reference Manual (last bookmark in the Acrobat .pdf version of this document). 

While on the topic of documentation: if you choose Cleanscape GUI, be sure to 
check out the Online Help facility!  It’s concise yet useful information.  The Table of 
Contents and many interrelated items in the help text are hyperlinked to make 
information access quick and easy. 

1.3 PURPOSE  

A. Function  

1. Flint is a programming tool that simplifies the debugging and maintenance of 
both large and small Fortran programs.  The Flint GUI provides ease-of-use 
enhancements to the venerable Flint command line product. 

2. The Flint source code analyzer that can detect over 1200 potential 
 problems, including:  

a. Inappropriate arguments passed to functions  

b. Inappropriate library calls  

c. Non-portable code  

d. Type usage conflicts across different modules  

e. Unused variables and dead code  

B. Application 

1. Flint can be used to:  
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a. Check source files before they are compiled  

b. Isolate obscure problems  

c. Identify problems before debugging is required   

C. Advantages  

1. The diagnostic messages produced by Flint are more detailed than those 
 produced by standard compilers, and cover a wider range of syntactic and 
 semantic problems.  

2. Flint analyzes source files both individually and as a group, and can therefore 
 identify problems that are beyond the scope of a compiler.  

3. Flint is effective in reducing development time and improves Fortran 
 programming style.  

D. Flow of Analysis  

1. The following flowchart illustrates the Flint test process:  
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PART II Requirements, Installation, and Uninstallation 

2.1 WINDOWS  

A. System Requirements  

1. Hardware  
Any configuration sufficient to run Windows is sufficient for Flint.  

2. Operating System  
a. Microsoft Windows 98® and 98® SE  
b. Microsoft Windows NT® 4.0 with Service Pack 6a (SP6a)  
c. Microsoft Windows 2000® with Service Pack 2 (SP2)  
d. Microsoft Windows XP® with Service Pack 2 (SP2) 
e. Microsoft Windows Vista® 

3. Web Browsers  
a. Microsoft Internet Explorer® 5.x or above  
b. Mozilla® 1.7 or Netscape Navigator® 4.7x or above  
c. Firefox® 1.2 or above 
d. Opera® 6.x or above  

B. Software Setup Procedure  

1. Installation  

a) Copy flintgui<ver>_win.exe to a temporary directory, then run it.  

b) An installer window should appear. Click the OK button. This should 
extract a number of files to “Cleanscape\flint\” under the directory 
contained in environment variable %PROGRAMFILES%.  For Win98, Flint uses 
c:\progra~1. The installer exits automatically, and no reboot is required.  

c) The installer automatically creates a shortcut for the Flint GUI on the 
desktop.  To run the GUI, double-click the shortcut.   

d) The installer adds the “main” subdirectory to your system PATH – necessary 
for running Flint (or any of its associated support programs) from the 
command line.  To do this manually, run this command: 

 set PATH=%PATH%;%PROGRAMFILES%\Cleanscape\flint\main 
e) Double-click the FortranLint icon on your desktop to start the program, and 

follow the instructions to obtain a license key. 
2. Additional steps for Windows 2000  

If you’re going to install Flint under Windows 2000 as Administrator, and you 
want to make the program accessible to ordinary “Users”, some additional 
steps are required. For more information, see Section 6.1. 
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C. Uninstallation  – manual process 

 a) Delete the following directory (including subdirectories):  
 %ProgramFiles%\Cleanscape\flint  

 b) Remove the Flint shortcut from the desktop  

 c) Delete the Cleanscape directory from your PATH: 
● In Windows 98, delete the appropriate “set path=” statement from your 

 c:\autoexec.bat file. 
● In Windows NT/2K/XP/Vista, right click your “My Computer” icon on 

 the desktop, select “Properties”, click the “Advanced” tab, click the 
 “Environment Variables”, double-click the text field “Path” in the System 
 Variables area, and from that string, delete 
 “c:\progra~1\Cleanscape\flint\main” (or equivalent). 

You can also restore your system to the point just before Flint installation – NOT 
available for Windows NT!  
The Flint installer created a Windows system restore point just prior to 
installation.  If you have not added new programs in the interim, you can safely 
roll your system back to this point.  For Win98, use “scanreg /restore”. 
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2.2 UNIX/LINUX  

A. System Requirements  

1. Hardware  
A minimum of 256 MB memory is required for Flint GUI.  

2. Operating System.  Note the GUI version may differ amongst the various hosts. 
a. Most GNU/Linux OSes, including RedHat®, SuSE®, Debian®, Ubuntu® 
b. Mac OS-X® Tiger  
c. Sun Solaris®  
d. HP HP-UX®, Tru64® 
e. SGI Irix® 
f. IBM AIX® 

3. Web Browsers  
a. Mozilla® 1.7 or Netscape Navigator® 4.7x or above  
b. Firefox® 1.2 or above 
c. Opera® 6.x or above  

B. Software Setup Procedure  

Installation – installation as root is easier and recommended.  Refer to the 
installation notes for details. The ‘#’ below represents the root prompt. 

a) Download the latest version of flintgui<ver>_<OS>.taz to a temporary 
directory, e.g., /tmp. 

b) Create installation directory, e.g., /usr/local/cleanscape, and cd to it. 
 NOTE: On Irix hosts, set environment variable CSIAPPBASE to this directory. 

c) Use the following commands to extract the files:  
 # gunzip  /tmp/flintgui<ver>_<OS>.taz 
 # tar xvf /tmp/flintgui<ver>_<OS>.tar 
d) Set the PATH: 

 # export PATH=/usr/local/cleanscape:$PATH 
e) Start the GUI: 
 # flintgui & 
 and follow the instructions to obtain a license key as described in Section 3. 

f) If this is a server-based application, start the daemon on the server as root: 
 # /usr/local/cleanscape/flintgui.dir/main/startup 
 NOTE: The daemon must be running on the server before clients can 

access/use the product. 
g) If you intend to run Flint from the command line, two additional commands 

are required (examples below are for sh/bash): 
 # export FLINTHOME=/usr/local/cleanscape/flintgui.dir/main 
 # export PATH=$FLINTHOME:$PATH 

C. Uninstallation  – manual process 

 Delete the following file and directory (including subdirectories):  
 /usr/local/cleanscape/flintgui  

 /usr/local/cleanscape/flintgui.dir 
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PART III Activating Flint  

A. Registration Process – GUI 

The first time that you run the program, a registration prompt will be displayed. 
You must "register" the program before you can use it. This will run every time 
the activation key (provided by Cleanscape) expires.  

1. If Flint is not registered, a dialog box will be displayed.  The following dialog 
will appear (NOTE: your server code will be different!): 

 

2.  To obtain your activation key, contact Cleanscape Software and provide the 
server code listed on the “Register Flint” window.  The “Server Code” is on the 
line with a yellow background.  HINT: Highlight the server code with your 
mouse, then type CTRL-C on your keyboard to copy the server code. 

 To reach Cleanscape, call 800-944-5468 (94-4LINT) or send email to 
support@cleanscape.net. 

3. Enter your name, company name and the activation key.  HINT: Copy the 
activation key from your email from Cleanscape, then paste it by typing 
CTRL-V on your keyboard.  When ready, press OK.  

4.  You should then see an “About Flint” dialog box.  At this stage, Flint is now 
registered and operational.  If you do not see this dialog box, contact 
Cleanscape for further assistance (see #2 directly above for contact info). 
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B. Registration Process – command line 

0.  If you wish, you can register the product using the GUI – the license key is 
created and stored correctly using either method.  Just be sure to set up the 
environment variables per the instructions in Section 2.1.B.1 or Section 2.2.B 
above!  If you use this method, you can skip the rest of this section. 

1.  Run the command, flint activate  

  Hit <Enter> to leave the number of license servers at its default of 1.  

 The next line from the activation program will contain your server code.  On 
Windows machines, it starts with “30720/”. 

 To obtain your activation key, contact Cleanscape Software and provide this 
server code. 

 To reach Cleanscape, call 800-944-5468 (94-4LINT) or send email to 
support@cleanscape.net.  

2.  Once the activation key is entered, Flint is registered and operational.  

 

 

 

 

 

The next three sections describe in detail 
the operation of Cleanscape C++lint 
• from the GUI    Part IV 
• from the command line Part V 
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PART IV Running the Flint GUI 

A. Overview  

The Cleanscape GUI is a tried-and-true graphical interface used successfully for 
years.  It is also the planned interface for future C/C++ and Java analyzers and 
test tools. 

The Cleanscape GUI provides hyperlinking between the various reports (in the 
Reports frame) and the line of source in the source file that caused the message.  

Advantages of the Cleanscape GUI include: 
• Fast 
• Easy to learn, navigate, and use 
• Information readily at the programmer’s fingertips 
• Point-and-click control for options-laden Flint command-line product.  NOTE:  

Your suggestions to improve this ease-of-use feature are appreciated!  Email 
suggestions/comments to sales@cleanscape.net. 

Supported code editors are below.  It is also possible for users to integrate their 
own editor!  See Section 6.2 for details on the seteditor program.  User 
contributions are welcome and will be placed in a “master” file at 
http://www.cleanscape.net/products/flint/contributed_editors.html 

Windows editors:
• Borland CodeWright 
• Crimson Editor 
• Emacs 
• Epsilon Programmer's Editor 
• GVim 
• GWD Text Editor 
• MultiEdit 

• Starbase CodeWright 
• TextPad 
• UltraEdit 
• Visual SlickEdit 
• Visual Studio 6 * 
• Visual Studio .NET 2003 * 
• Visual Studio 2005 *

Unix/Linux editors: 
• Elvis 
• Emacs 
• Jed *  
• Joe *  
• Nano * 

• NEdit 
• Pico *  
• Vi *    
• Vim *   
• XEmacs

* Multiple instances of these editors will open with each link click. 

All elements of the GUI are also controllable from the keyboard; this is discussed 
in Section K below. 

The following screenshots depict a sample Flint session.   

NOTE:  A sample Unix/Linux screen shot is shown in addition to one from 
Windows.  All subsequent screen shots are Windows-based, but 
the functionality is identical between the two environments. 
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The Crimson Editor (previously selected as shown in the Reports tab in the lower 
left frame) was activated when the red “33” hyperlink near the top of the Analysis 
Report was left-mouse-clicked.  Flint positioned the editor to the line in the 
source file that caused the analysis result.   

It is possible to open any file listed in the Project window (upper left frame of the 
GUI) by right-mouse-clicking on the desired filename. 

The Flint GUI remembers settings (e.g., checkboxes, include path, external editor 
– but not filenames) from the previous session by creating a template file in the 
bin subdirectory or your $HOME directory on Unix/Linux.  There is no template file 
upon installation.  
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B. Components  

Where possible, each component features “balloon” help which will appear if you 
hover the mouse over an item or control description.  Additional help for each 
item may be found in the Online Help (see Section 4.I). 

1. Program menu:  

2. Shortcut bar:  
 

3. Project window:  

 
Any file listed in the Project window can be opened in the selected editor by 
right-mouse-clicking the filename.  Any filenames too long to fit the window 
are shorted to ~60 characters and an ellipsis is prepended.  The full filename 
appears in a balloon tip if hovering the mouse over the name, as shown above. 

4. Project shortcut buttons:  
 

5. Lint Analysis tab (with “Portability” listbox activated).  Flint provides 12 
portability options to help determine issues porting your code to different 
hosts.  The ANSI77 and ANSI90 options are the most commonly used. 

 This kind of point-and-click control makes using the options-laden Flint 
command-line product easy!  NOTE:  Your suggestions to improve this feature 
are appreciated – email suggestions to sales@cleanscape.net. 

USAGE NOTE: Due to the rich extent of Flint analyses, it is recommended that 
first-time projects turn off FYI and dataflow analysis, then progressively add 
levels once prior analyses are assessed/ addressed.  Individual analyses can 
be enabled/disabled by number in the appropriate text box on the 
Miscellaneous Options tab. 
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6. Source Config tab.  “Dialect” is analogous to “Portability”; an example in 
English is, “Tell Flint that the incoming source was written for a Solaris 
compiler (dialect) and I want to know issues porting to a Lahey compiler 
(portability)”.  Also note the preprocessor option: if checked, Flint will search 
for cpp in your PATH; you can define a new path and/or preprocessor name 
(e.g., the fpp that came with your Fortran compiler) in the textbox at bottom:  

 

7. Report Options tab (External Editor dropdown):  

 

 

 

 

 

 

 

 

8. Miscellaneous Options tab:    
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9. Report windows:   

Example reports appear in Section H below. 

C. Creating a new project  

1. To create a new project, select Project/New from the menu or press the 
 New Project button on the shortcut bar.  Note: If a project is already open, a 
 dialog box will prompt you to save the old project first.  

 
 

2. A new project name appears in the title, which can be saved to any desired 
 name later. 

D. Opening an existing project  

1. To open an existing Cleanscape GUI project, select Project/Open from the 
 menu or press the Open Project button on the shortcut bar:  
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2. The Open window will appear:  

 

 

 

 

 

 

 

 

 

 

 

 
a. Browse to find/select a project file (with extension .csi).  

b. When ready, press the Open button in the lower right corner.  

3. Files associated with the project are displayed in the Project window:  

 

4. It is also possible to open recent projects using the Recent Projects menu: 
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E. Saving a project  

1. To save the current state of a project, select Project/Save from the menu or 
 press the Save Project button on the shortcut bar: 

 

2. If this is a new project, the Save As window will appear.  

a. Enter a name for the project.  

b. When done, press the Save button. 

c. You can also use the “Save As…” feature in the Project dropdown to save an     
existing project under a new name. 

F. Modifying a project  

1. Add files to a project  

 a. To add one or more files to a project, select File/Add File from the menu to 
  add files into the project or press the Add File button on the project  
  shortcut bar:  
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b. The Add file window will appear:  

 
c. For the Flint GUI, Fortran source files will be the default file type (.f, .f90).  

UNIX NOTE: The default file type is .f90, which can be modified by entering 
the appropriate type (e.g., *.F) in the Filter textbox at the bottom of the dialog. 

1) The file-selection dialog supports multiple-file selection under both MS-
Windows and UNIX.  

2) To add multiple files individually, use <Control> + Left Mouse Button.  Each 
selected file will be highlighted. 

3) To add a group of files:  

(i)  Left-click on the first file.  

(ii) Hold down the <Shift> key.  

(iii) Click the last file desired.  The first, last, and all files in-between will be 
highlighted.  

(iv) When done, press the Save button.  

2. Removing files from a project  

a. To remove individual source files from a project, select the files to be 
removed, and then press the Remove File button.  To remove all files from a 
project (i.e., to clear the file list), first press Select All, and then press the 
Remove File button. 
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b. Press the OK button to confirm the removal operation:  

 
c. The updated file list is displayed in the project window.  

d. Note that this operation has no effect on the actual file on-disk. 

G. Execute test  

1. Create a new project or open an existing project for testing.  

 To create a new project, see Section4.C.  

 To open an existing project, Section 4.D.  

2. Select the files to be analyzed as explained in Section 4.F.1. 

3. Modify options as necessary, using the tabs in the lower left frame of the GUI, 
as displayed in Sections 4.B.5-8.  See balloon help, Online Help, and the Flint 
Reference Manual (last bookmark in the Acrobat .pdf version of this file) for 
descriptions of each option. 

4. To analyze the selected files, use Process/Analyze Files from the menu or 
 press the Execute test button on the shortcut bar:  

 

H. Review reports  

1. To view the generated reports, click on the appropriate report tab:  

 

2. To print reports, or to save them to disk, use the Report menu dropdown at 
the top of the screen. Reports may be printed or saved collectively or 
individually.  

3. Samples of each of the four reports are depicted below.  Remember that 
clicking any entry in red will open the source file at the appropriate source line 
in the specified External Editor. 
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I. Online Help 

The Online Help System contains concise yet useful information for running the 
Cleanscape GUI.  The Table of Contents and many interrelated items in the help 
text are hyperlinked to make information access quick and easy.  

1. Accessing the Help System  

a. To access the online help system, select Help/Contents and Index from the 
menu or press the Help button:  
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b. The Flint Help browser will appear:  

 
J. Sub-Menu Functions  

There are several “right-mouse-click” options available while in the Reports frame 
on the right hand side of the GUI.  These features should be self-explanatory for 
those familiar with graphical environments.  The more commonly used features 
are shown in detail below. 

1. Copy  

a. Press the right mouse button inside reports frame  

b. Select Edit -> Copy  

 

c. The text can now be pasted into other applications (e.g., Microsoft Word). 

2. Search  
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a. Press the right mouse button inside a report frame.  

b. Select Search -> Find. 

c. Enter string to search and select the desired options: 

 
d. The search result(s) will be highlighted. 

3. Line Wrap  

a. Press the right mouse button inside a report frame  

b. Select View -> Wrap. The default is None.  
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K. Operating the GUI using the Keyboard; Keyboard Shortcuts  

All aspects of the Flint GUI can be controlled from the keyboard.  This capability 
was added to comply with the US Government’s Section 508 provisions. 

1. Accessing dropdown menus and items using keyboard accelerators.  This is 
the standard mode common to all Windows products. 

a. Select the desired menu by holding down the <ALT> key, then pressing the 
underlined letter for that menu item.  For instance, this screen image was 
obtained by pressing and holding <ALT>, then typing the “h” key: 

 
b. To open the GUI manual, release the <ALT> key and then press “g”. 

2. Navigating amongst screen elements.  There are 5 screen elements in the GUI, 
as shown below: 

 
a. The <TAB> key scrolls between these five screen elements and all active 

items within each element.  <SHIFT>+<TAB> reverses the scrolling.  The 
item with focus will have a dotted line around its border.  Note:  Because 
of the background color, the icon buttons in Element 1 will not show the 
dotted-line highlighting. 

5 2 

3 

4 

1 
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b. For buttons (including radio buttons), pressing the space bar will “push” 
the button. 

c. For checkboxes, pressing the space bar will “check/uncheck” the box. 

d. For dropdown boxes, pressing the space bar will open the dropdown; the 
up/down arrows will navigate the dropdown, and the <ENTER> key will 
select. 

3. Keyboard shortcuts. 

a. The standard Windows shortcuts are available.  For instance, pressing 
<F1> will bring up the Help listing; <ALT>+<F4> exits the program. 

b. Use the alt-key combination to access a menu, then type just the 
underlined letter to access a submenu item.  For instance, to invoke 
Project-Save As, one would type <ALT>+<p>, then <a>.  Alternately, the 
arrow keys can be used to navigate submenu selections once the menu 
dropdown has been activated with <ALT>+<p>. 

c. The following keyboard shortcuts are also available within the GUI: 
 <ALT>+<o>  Open Project 
 <ALT>+<g>  Run the Analysis (Go) 
 <ALT>+<x>  Exit GUI 
 <ALT>+<l>  Jump to Lint analysis tab (in Element 4) 
 <ALT>+<c>  Jump to Source Config tab (in Element 4) 
 <ALT>+<r>  Jump to Reports tab (in Element 4) 
 <ALT>+<m>  Jump to Misc Options tab (in Element 4) 
 <ALT>+<1>  Jump to Report #1 (Analysis report in Element 5)  
 <ALT>+<2>  Jump to Report #2 (Statistics report in Element 5) 
 <ALT>+<3>  Jump to Report #3 (Xref report in Element 5) 
 <ALT>+<4>  Jump to Report #4 (Call tree report in Element 5) 

  

L. Changing fonts / sizes  

To change the fonts and sizes within the GUI, use a text file to edit the flint.ini 
file located in the main subdirectory on Windows or your $HOME directory if 
Unix/Linux.    

In that file, you will see a section starting with [fonts].  Change the values from 
default to a value specified as follows: 

name size style 
where name is any font name on your system defined by a single word; 
 size is an integer font size, and 
 style is one of:   normal   bold   italic   underline 
NOTE: The GUI makes no attempt to validate the font, size, or style.  Windows 
are not resized due to such changes, and results are unpredictable if the 
specified font is not valid on your system. 
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PART V Running Flint from the Command Line  

A. Introduction 

Flint has a command line facility suitable for standalone operation or for 
inclusion in scripts, e.g., for “make lint” purposes. 

For details on the actual operation of Flint and its control and reporting options, 
refer to the companion document, Flint Reference Manual (last bookmark in the 
Acrobat .pdf version of this file). 

B. Operation 

To run Flint in command line mode, you need to have set the environment 
variables as defined in Section 2.1.B.1 or Section 2.2.B and registered the 
product as described in Section 3. 

The format of the Flint command line is quite simple: 
flint <parameters_to_be_supplied_to_PC_lint> <source_filename(s)> 
Entering flint without parameters yields a command summary. 

Details on all the command line parameters may be found starting in Chapter 3 
of the Flint Reference Manual (last bookmark in the Acrobat .pdf version of this 
file). 

Other important sections in the Flint reference manual include cross-reference 
format/content sub-options (Chapter 8), in which very finely honed cross-
reference results may be obtained, and the Unix install guide (Appendix A), 
which also provides details on the license daemon (not used under Windows). 

C. Return Codes 

A return code of zero (0) indicates that Flint ran and ran successfully without 
encountering any source errors. 

A return code >1 indicates that either 

• There was a problem securing a valid license key to run the program, or 

• There were one or more messages resulting from the Flint analysis over the 
source code. 

A detailed description is of course available in the analysis report.  If there was a 
problem starting the program or securing a key, contact support@cleanscape.net.  
If you are under maintenance, you may also contact Cleanscape Support for 
questions regarding any analysis output message. 

For more information Flint’s return codes and their uses, see Section 6.5 of the 
Flint Reference Manual (last bookmark in the Acrobat .pdf version of this file).   
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PART VI MISCELLANEOUS INFORMATION  

6.1 ADDITIONAL STEPS FOR WINDOWS 2000  

A. Important note 

1. This section applies to users running Windows 2000 who belong to the 
 “Users” group, and only to that group.  

B. Details  
1. For Flint to run correctly under Windows 2000, users must have “write” and 

“modify” access rights to the directory “C:\Program Files\Cleanscape” and all 
sub-directories under it. This document explains the procedure used to 
change the access rights described above.  
a. Log in as “administrator” and finish installing Flint. 
b. Double-click on the “My Computer” icon on the desktop. 
c. Double-click on the “Program Files” folder, then right-click the “Cleanscape” 

folder.  Select Properties from the sub-menu.  
d. Select “Security” tab on the Cleanscape Properties screen:  

 
e. Select the “Users” group and enable the “Modify” and “Write” permission.  
f. Click the “Apply” button.  
g. Click the “OK” button. This should close the Cleanscape Properties window.  
h. Flint is now ready to run on Windows 2000 for the “Users” group. 
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6.2 ADDING AN EXTERNAL EDITOR TO THE GUI USING SETEDITOR  

A. Introduction 

By popular demand, Cleanscape has added the ability for users to add their own 
favorite editor to any Cleanscape GUI (as opposed to submitting a feature request 
to Cleanscape Support).  This is implemented via an external program called 
seteditor, located in the ‘bin’ subdirectory. 

User contributions welcome!  Send them to support@cleanscape.net; any 
contributions will receive appropriate credit and be placed in a “master” file 
located at http://www.cleanscape.net/products/flint/contributed_editors.html 

B. Operation 

Windows. 

You can either run seteditor from the command line or via Explorer. 

From a DOS shell (cmd or command prompt), run the following command: 
"%PROGRAMFILES%\cleanscape\flint\bin\seteditor" 
From Explorer, navigate to the above directory and then double-click 
seteditor.exe. 

Unix. 

From a shell prompt, run the following command: 
/usr/local/cleanscape/bin/seteditor 

Three pop-up dialogs (Windows) or a sequence of shell interactions (Unix/Linux) 
will guide you through 
1. Naming the editor for the Editor dropdown in the Cleanscape GUI 
2. Locating the editor executable itself 
3. Setting command line parameters to open a file and jump to a line number.  

A sample Windows session depicting the dialogs for all three steps (and labeled 
as such) is shown on the next page.  

NOTE:  Refer to your editor’s documentation to get the editor’s command line 
information required (i.e., specifying the filename to open and the line number to 
jump to when opening the file).  If your editor does not support jumping to line 
numbers from the command line, you can still invoke the editor but it will be 
impossible to align the analysis message to the “offending” source line. 

Any number of editors may be added in this fashion.  Added file information is 
stored in file myeditors.lst, located in bin subdirectory on Windows or your $HOME 
directory if running Unix/Linux. Once successfully added, email your 
myeditors.lst file to support@cleanscape.net for inclusion in a Master file to 
share with other Cleanscape customers! 

It is also possible to edit myeditors.lst manually; see the comments inside the 
file.  A Unix/Linux session is shown below, as are the contents of myeditor.lst 
(which looks substantially similar under Windows). 
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